
New in Media Composer v2021.3
What’s New for
Avid® Media Composer® v2021.3

New in Media Composer v2021.3

The following are new for Media Composer v2021.1

• Support for macOS

• Interface Brightness Setting Update

• Bin Status Bar

• New Highlight Colors

• Vertical Title Bar Improvements

• Mappable Sync Lock All Button

• Moving Segments in the Timeline

• Group Clip Name in Timeline Clip Text

• Find Bin

• PhraseFind and ScriptSync Farsi Support

• IMF Original and Supplemental Support

• Avid Titler+ Updates

Support for macOS

This release adds support for macOS v11.2.3.

Interface Brightness Setting Update

A new mid-gray brightness selection has been added to the Interface brightness options. See File > 
Settings > Interface. Click the General tab. 
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New Highlight Colors

Gold and blue have been added to highlight colors. See File > Settings > Interface. Click the General 
tab to see the new options. 

Bin Status Bar

Display the Bin Status Bar to show how many items are seen and selected in a bin. To enable the Bin 
Status Bar, go to the Bin fast menu or select File > Bin and select Show Status Bar.

The number of items in the bin will appear at the bottom right of the bin.
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When you select items in the bin, the number selected will also appear in the status bar.
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You can hover over Viewing or Selected to see tooltip info on the items in the bin. 

The information in the status bar changes if you enter text in the Quick Find field or if you perform a 
Sift on the bin contents.

You can choose to override displaying the Bin Status bar. See the Bins tab in the Interface Settings.
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Vertical Title Bar Improvements

To improve readability, the font in the Vertical Title Bar is now white no matter which Interface 
brightness is selected. The kerning of the text on the Vertical Title Bar has been improved for 
readability also.
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Mappable Sync Lock All Button 

The Sync Lock All Tracks button has been added to the Edit tab of the Command Palette. You can 
map this button to the keyboard to easily enable and disable all Sync Locks in the Timeline when the 
Timeline window is active.

Moving Segments in the Timeline

With this release, you can move segments in the Timeline up and down without leaving filler each 
time the segment is moved consecutively. This also applies to moving segments horizontally using 
the Trim left and Trim right keys.

IMPORTANT: This only applies with repeated up/down and left/right movement. If there is a change 
to the segment selection or more than 5 seconds have passed after the last move, moving segments 
will leave filler behind.

n After dragging segments up or down, the segments remain selected. 

n After performing an Undo segment selection is restored.
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Group Clip Name in Timeline Clip Text

An additional Clip Text option has been added to the Timeline Fast Menu. You can choose to display 
the Group Clip name in the Timeline clip text. 

Find Bin

You can easily access the Find Bin command directly in the Timeline when pointing over a segment. 
Simply right-click over the desired segment and select Find Bin to highlight the clip in the Bin. If the 
clip is in a closed bin, the bin opens and the clip is highlighted.
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PhraseFind and ScriptSync Farsi Support

The Farsi language is supported with PhraseFind and ScriptSync.

Media Composer installs the English language for PhraseFind and ScriptSync automatically. To 
install support for additional languages, download the Language Pack installer from your Avid 
Master Account.

For additional information, search the Help for “Farsi Information.”

IMF Original and Supplemental Support

The Interoperable Master Format (IMF) is an international standard for the file-based interchange of 
multi-version, finished audio-visual works.You can link to and create IMF originals or supplementals 
using the IMF Window.

IMF Window Overview

The IMF window initially displays as empty and provides two panes that include a sidebar on the left 
and a related right pane which populates based on the selection in the sidebar. The right pane can also 
be collapsed.

When the IMF window is populated it consists of the following:

IMF Window Sidebar (left panel), Metadata and parameters (right panel)

Area Item Description

Sidebar (left panel) Explore button Allows you to navigate the file system to link to an existing 
IMF package by selecting the root folder in the navigation 
window. Once selected, the package and related contents 
will populate the sidebar.

New IMF button Allows you to create a new IMF Original or Supplemental. 
Once picked, a root folder and IMP will appear in the 
sidebar. Note that neither of these exist on disk yet
8



New in Media Composer v2021.3
IMF contents structure The sidebar also populates with IMF Originals and 
Supplementals and provides a tree-like structure in the 
Name column to reveal the contents of the IMF packages. 
The status column to the right of Name populates indicating 
the status of the IMF elements.

• Green = has been exported and exists on disk,

• Yellow = all required metadata fields are populated and 
the directory is set. the package is ready to be writted to 
disk by clicking the Export button.

• Red = required fields must be completed before the 
Export operation is available and package can be 
written to disk.

Sequences from bins can be dragged to packages and CPLs 
can be dragged to Bins to create Media Composer 
sequences. Making a selection in the sidebar populates the 
right-pane with the item's associated metadata. 

Export button This button becomes active only when a selection is made 
and all required fields for the Original or Supplemental are 
satisfied (such as setting a target path). If the selection is 
read-only (green) or required fields still exist (red), the 
Export button is disabled

Metadata and 
Parameters (right 
pane)

When selecting a package that exists on disk, or any IMP or 
CPL within it, the right pane populates with read-only 
metadata and parameter values. For example:

• Selecting the root folder will display the IMF name as it 
appears on disk and it's directory path, along with 
Issuer, Creator and Annotation metadata.

• Selecting an IMP displays the IMPname, Issuer, Creator 
and Annotation. Note that the IMP name is read-only 
and for an un-committed IMP it will display as untitled. 
Once committed, the untitled name will be replaced 
with the file name on disk as it is generated from Media 
Composer.

• Selecting the CPL will display the Content Title and 
CPL file name on disk. Additional structural and 
descriptive metadata is displayed below that. Note that 
when a sequence is dragged into the package sidebar, 
Content Title is automatically populated with the 
sequence name. This can be changed unless the CPL 
has been committed. 

Area Item Description
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To link to the IMF original:

1. Select Tools > IMF Window.

2. Click the Explore button and navigate to an existing IMF original. Once selected, the package 
will display in the IMF window sidebar.

Expanding the package folder reveals the package's IMP(s) and CPL(s). Selecting the folder, 
IMP or CPL will load the associated metadata in the right pane. NOTE: Because this package is 
read only, no metadata or parameters can be adjusted. 
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3. Drag the CPL from the sidebar into a Bin to create a Media Composer sequence. You can modify 
this sequence without affecting the original CPL.

To add to an existing package:

1. Once the sequence is edited, or a new sequence is edited with material from the originating 
package, be sure all desired tracks are enabled, then drag the sequence to the root folder of the 
IMF window. Note that any tracks not enabled will be skipped. 

When a sequence is dragged into the package, the sequence name is displayed with the prefix 
CPL_sequence name. The Content Title metadata field in the right pane is populated. If you 
change the Content Title field in the right pane, the name will update in the sidebar. NOTE: Once 
you commit the package, the file name on disk is generated from Media Composer and is 
displayed in the right pane under Content Title. 

2.  Select the CPL, modify the parameters in the right pane for the encoding profile and complete 
required metadata field. Completing Issuer and Creator automatically populate the IMP and root 
folder required fields. You can change these independently if desired. 

For example, a CPL can have unique Issuer and Creator metadata from the IMP and the root 
folder by changing the respective fields in the IMP and or root folder. If two or more CPLs exist, 
the IMP and root folder populate based on the first CPL Issuer and Creator fields being 
populated. Adding different metadata to two or more CPLs does not change the IMP or root 
folder metadata. 

3. Select the root folder in the sidebar and establish the target directory and add Annotation and/or 
change either the Issuer and/or Creator fields if desired. 

4. Click on the Commit button. Once complete the status changes from yellow to green. 
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To create a new Original or Supplemental Package:

1. Click the New IMF button at the top of the left pane sidebar and select IMF Original or IMF 
Supplemental. Or drag a sequence to the sidebar.

A new untitled folder appears in the sidebar (though it is not yet written to disk).

2. Rename the folder and set the Directory path. 

3. Drag one or more sequences from a Bin into the folder. If you expand the folder, you will see a 
new untitled IMP and a CPL(s) with the name of the sequence. Both have a status of red.

4. Select the CPL and define parameters and metadata. Once the required fields are completed, the 
status changes to yellow.

5. Set the directory path, select the root folder and click the Export button. Once complete, the 
status changes from yellow to green for the IMP and sequence(s). 

Note that if you add additional sequences after the first drag and drop into the folder, a new IMP 
is created.
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n Committed and uncommitted packages can be removed from the sidebar by selecting the root folder 
and deleting. Note that it is only removed from the UI and nothing is removed from disk.

MultiChannel Audio Mapping

The Audio Mapping section allows you to map sequence tracks to IMF output tracks.

The left-hand menu defaults to All Active Tracks, but selecting the menu will show all the tracks in 
the sequence as well as their format:

In addition, clicking on the Audio Tracks Grouping button will open a window that allows you to 
group together contiguous or non-contagious tracks into a single group that can be applied to the 
output. Note that these settings do not persist beyond the selected sequence. Also note that the group 
can include or exclude the Master Fader.
13



New in Media Composer v2021.3
Once saved, the group will appear in the tracks list at the bottom:

Once the sequence tracks have been defined, the IMF track format can be selected in the right-hand 
menu:
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To add another IMF audio track, click on the plus button. Doing so will add another row for 
definition. To remove a row, click on the Minus button:

MultiChannel Descriptive MetaData

You can add Content Kind, Spoken Language and Region metadata to individual output tracks. To 
enter this metadata, click on the edit button to the right of the IMF track format menu and the left of 
the + button. 

Clicking on the button opens the Multi-Channel Audio Metadata window.

Selecting an MCA Language will also populate the respective regions if available. In addition, you 
can select an MCA Content Kind value as well:

Note that hovering the mouse over the button reveals a tool tip that shows the current metadata values 
for that output track. 
15



New in Media Composer v2021.3
IMF Supported Formats

The following formats are supported when working with IMF.

Project Format Raster Dimenstion Frame Rate

HD 1920 x 1080p YCbCr Color Space:

23.976p

24p

25p

29.97p

30p

50P

59.94p

60p

RGB Color Space:

23.976p

24p

25p

29.97p

30p

50P

59.94p

60p

2K 2048 x 1080p YCbCr Color Space:

23.976p

24p

25p

29.97p

30p

50P

59.94p

60p

RGB Color Space:

23.976p

24p

25p

29.97p

30p

50P

59.94p

60p

UHD 3840 x 2160p YCbCr Color Space:

23.976p

24p

25p

29.97p

30p

50P

59.94p

60p

RGB Color Space:

23.976p

24p

25p

29.97p

30p

50P

59.94p

60p
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Avid Titler+ Updates

The following updates have been made to Avid Title+: 

Creating Text Boxes

Creating title text and resizing title boxes wraps the title text paragraphs appropriately. Simply select 
the T in the Avid Titler+ toolbar and drag in the Record monitor to create the Title box.

Type the text. When you resize the text box, the text will wrap appropriately.

4K 4096 x 2160 N/A RGB Color Space:

23.976p

24p

25p

29.97p

30p

50P

59.94p

60p

Project Format Raster Dimenstion Frame Rate
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Changing the size of the text box wraps the text appropriately. 

Opacity Control for Gradient Color

You can select the exact value for the Alpha Channel. Double-click the Face color option in the 
Titler+ toolbar.
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The Select Color window opens.

Color Picker (Windows)

Color Picker (macOS)

Here you can set the opacity value of the Alpha channel. 
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Change to Cursor

With this release, the cursor has been updated. The cursor is taller and flashes making it easier to 
locate.

Rotating Text Boxes and Shapes

After creating a text box or a shape, you can use the Rotation Icon to rotate the box or shape. Simply 
hover over one of the bounding box corners and select the Rotation Icon to rotate the image. You can 
also hold down the Shift key while dragging to rotate the shape in increments of 15 degrees.
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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may only be 
used in accordance with the license agreement.

This product may be protected by one or more U.S. and non-U.S patents. Details are available at www.avid.com/patents.

This document is protected under copyright law. An authorized licensee of Avid Media Composer may reproduce this publication for the 
licensee’s own use in learning how to use the software. This document may not be reproduced or distributed, in whole or in part, for 
commercial purposes, such as selling copies of this document or providing support or educational services to others. This document is 
supplied as a guide for Avid Media Composer. Reasonable care has been taken in preparing the information it contains. However, this 
document may contain omissions, technical inaccuracies, or typographical errors. Avid Technology, Inc. does not accept responsibility of 
any kind for customers’ losses due to the use of this document. Product specifications are subject to change without notice.

Copyright © 2021 Avid Technology, Inc. and its licensors. All rights reserved.

The following disclaimer is required by Apple Computer, Inc.:
APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, REGARDING THIS 
PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR 
PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY 
NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. THERE MAY BE OTHER RIGHTS THAT 
YOU MAY HAVE WHICH VARY FROM STATE TO STATE.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:
Copyright © 1988–1997 Sam Leffler 
Copyright © 1991–1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose is hereby 
granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and 
related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to 
the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, 
INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR 
PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT 
OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
This software is based in part on the work of the Independent JPEG Group.

This Software may contain components licensed under the following conditions:
Copyright (c) 1989 The Regents of the University of California. All rights reserved. 

Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph are 
duplicated in all such forms and that any documentation, advertising materials, and other materials related to such distribution and use 
acknowledge that the software was developed by the University of California, Berkeley. The name of the University may not be used to 
endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED ``AS 
IS'' AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 

Copyright (C) 1989, 1991 by Jef Poskanzer. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, 
provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in 
supporting documentation. This software is provided " as is"  without express or implied warranty. 

Copyright 1995, Trinity College Computing Center. Written by David Chappell. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, 
provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in 
supporting documentation. This software is provided " as is"  without express or implied warranty. 

Copyright 1996 Daniel Dardailler. 

Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that the above 
copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation, 
and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to distribution of the software without specific, 
written prior permission. Daniel Dardailler makes no representations about the suitability of this software for any purpose. It is provided " as 
is"  without express or implied warranty. 

Modifications Copyright 1999 Matt Koss, under the same license as above. 

Copyright (c) 1991 by AT&T. 
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New in Media Composer v2021.3
Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice 
is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the supporting 
documentation for such software. 

THIS SOFTWARE IS BEING PROVIDED " AS IS" , WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, NEITHER 
THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE MERCHANTABILITY 
OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

This product includes software developed by the University of California, Berkeley and its contributors.

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:
“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code equivalent of 
“Install-It,” including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shall in no event be liable for any damages 
resulting from reseller’s failure to perform reseller’s obligation; or any damages arising from use or operation of reseller’s products or the 
software; or any other damages, including but not limited to, incidental, direct, indirect, special or consequential Damages including lost 
profits, or damages resulting from loss of use or inability to use reseller’s products or the software for any reason including copyright or 
patent infringement, or lost data, even if Ray Sauers Associates has been advised, knew or should have known of the possibility of such 
damages.

The following disclaimer is required by Videomedia, Inc.:
“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with respect to 
its merchantability or its fitness for any particular purpose.”

“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by Videomedia, 
Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use of this software will allow 
“frame accurate” editing control of applicable videotape recorder decks, videodisc recorders/players and the like.” 

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample Source 
Code:
©1993–1998 Altura Software, Inc.

The following disclaimer is required by Ultimatte Corporation:
Certain real-time compositing capabilities are provided under a license of such technology from Ultimatte Corporation and are subject to 
copyright protection.

The following disclaimer is required by 3Prong.com Inc.:
Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.

The following disclaimer is required by Interplay Entertainment Corp.:
The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid products.

This product includes portions of the Alloy Look & Feel software from Incors GmbH.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

© DevelopMentor

This product may include the JCifs library, for which the following notice applies:
JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third Party 
Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in connection with Avid 
Interplay.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or “commercial 
computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a unit or agency of the 
U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the License Agreement, pursuant 
to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
Avid, the Avid Logo, Avid Everywhere, Avid DNXHD, Avid DNXHR, Avid Nexis, AirSpeed, Eleven, EUCON, Interplay, iNEWS, ISIS, Mbox, 
MediaCentral, Media Composer, NewsCutter, Pro Tools, ProSet and RealSet, Maestro, PlayMaker, Sibelius, Symphony, and all related 
product names and logos, are registered or unregistered trademarks of Avid Technology, Inc. in the United States and/or other countries. 
The Interplay name is used with the permission of the Interplay Entertainment Corp. which bears no responsibility for Avid products. All 
other trademarks are the property of their respective owners.  For a full list of Avid trademarks, see: http://www.avid.com/US/about-avid/
legal-notices/trademarks.

Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other 
countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. Windows is either a 
registered trademark or trademark of Microsoft Corporation in the United States and/or other countries. All other trademarks contained 
herein are the property of their respective owners. 
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